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Introduction 

What is Mindjet Connect® SP? 

Mindjet Connect SP enhances Microsoft SharePoint, delivering a powerful collaborative work solution that 
gives people the ability to access SharePoint content, manage SharePoint tasks, and work together more 
effectively on projects — all through an intuitive visual framework. Mindjet Connect SP’s interactive maps 
help people get on the same page and stay in sync. 

Mindjet Connect SP lets you: 

 Create new maps from SharePoint document libraries. 

 View and edit maps from within SharePoint using your browser or using MindManager for Windows. 

 Create task dashboards on maps by including SharePoint Linker topics that are dynamically linked to 
SharePoint tasks. 

 Create new SharePoint tasks directly from the map. 

 Use the Mindjet Connect SP Web Part to display interactive maps on SharePoint pages. 
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Creating and editing maps 

Create a map in 7 easy steps 

Here's how to begin creating a map using Mindjet Connect SP right away. 

 Begin a new map: 

On the document library's ribbon, on the Library Tools Documents tab, click New .mmap file. 

 

Enter the map's name, and then click OK. 

The new map will open in the Mindjet Connect SP mapping window where you can add topics to your 
new map. 

 Enter your main idea: 

In the mapping window, the Central topic is already selected. 

Type the main idea or theme of your map and press Enter. 

  

   Add supporting ideas: 

To add a main topic press Enter, type the topic text, and press Enter. 

To add another main topic, press Enter again. 

To add a subtopic, press Insert. 
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   Add other map elements: 

 

 

The Home and Insert tabs on the mapping window ribbon contain commands for adding more map and 
topic elements such as: 

Floating topics   Callouts    Hyperlinks      Attachments   Notes     Images  

 
Relationships    Boundaries     SharePoint task dashboards 

 Code topics with visual information: 

Select a topic, and then use commands on the ribbon's Insert tab to apply Markers ( Icons and  textual 
Tags ). 

 

If your current topic is a task, you can apply Priority and Progress icons*  from the ribbon's Home tab, or 
click Task Info to open the Task Info pane where you can fully define the task's attributes. 

*NOTE: When you change these icons on a topic in a SharePoint task dashboard, the related 
SharePoint task is also updated. You cannot modify other task info for tasks that are SharePoint 
Linker results. You can modify their properties only by editing the SharePoint task. 
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  Format the map: 

 

Select one or more topics that you want to format. 
(To select multiple topics, hold CTRL and click on topics, or drag the selection rectangle.) 

You'll find commands on the Home tab for changing the font used for topic text and the topic's 
appearance. 

Additional formatting options can be found on the Design tab. Use the Growth and Topic Lines options 
to change the map layout. 

  Save your changes 

When you finish editing the map, save it to commit your changes.  

Click File, and then click Save to save your changes.  

 

When you are finished with the map, you can use commands in the File menu to Close the map and 
return to document library page. Mindjet Connect will notify you if any changes have not been saved.  

 

See also: 

Mapping in Mindjet Connect 
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Create a new Map 

You can create a new map from any documents library (such as Shared Documents). 

NOTE: Your ability to create new maps is controlled by your permissions in SharePoint. 

1. Open the documents library. 

2. On the library's Documents tab, click New .mmap file. 
 

 

3. Enter the name for the map you want to create, and then click OK. 

The new map opens in Mindjet Connect SP, where you can add content. 

HINT: If you already have maps that you have created in MindManager on your desktop, you can upload 
these using the SharePoint Upload Document command, and then view and edit them in Mindjet 
Connect SP. 

See also: 

Mapping in Mindjet Connect 
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View or edit a map in the browser 

You can view or edit your map in the browser using the built-in Mindjet Connect SP mapping commands. 

NOTES:  
Your ability to open and edit maps is controlled by your permissions in SharePoint.  
If another user has the map checked out you cannot edit it. 

What do you want to do? 

View a map in the browser 

Edit a map in the browser 

  

View a map in the browser 

To view a map (open it in Read-only mode) in Mindjet Connect SP: 

 Point to the map name in the document list, click the down arrow, and then click View in Browser. 

The map will open in Mindjet Connect SP in Read-only mode. You'll see the Read Only indicator at the 

upper-left.   You can use the commands on the ribbon to view the map, but you cannot 
edit it. 

To switch to editing mode: 

 On the Mindjet Connect SP View tab, click Edit in Browser. 

Edit a map in the browser 

HINT: To prevent others from making changes to the map at the same time, you can use the 
SharePoint commands to check it out. You are not required to check out the map before 
editing, unless this setting is enabled in your SharePoint environment. 

To open a map for editing in the browser: 

 Point to the map name in the document list, click the down arrow, and then click Edit in Browser. 

The map will open in Mindjet Connect SP for editing. 

See also: 

Mapping in Mindjet Connect 

Edit a map in MindManager 
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Mapping in Mindjet Connect 

Map topics and elements 

  

Topics 

Use commands on the Ribbon's Home tab to add basic map elements. when a new topic appears, it is 
automatically selected so you can enter its text. 

 

Central topic 

The main theme or title of your map. 

 Always present when you start a map. 

 

Main topics 

The major ideas that make up the theme. 

 Select the central topic (or no topic). 

 Click Topic, or press ENTER. 

 

 

Topics and 
Subtopics 

Details about main topics. 

Select a topic. 

 Click Topic or press ENTER to create a topic at the same level. 

 Click Subtopic or press INSERT to create a topic at the next level. 

 

Callouts 

  

Additional information for a specific topic, relationship, or summary information 
for a boundary. 

 Select a topic, relationship, or boundary. 

 Click Callout or press CTRL+SHIFT+ENTER. 

 Enter your text when the callout appears. 

 

Floating topics 

Auxiliary information or text. 

 Click a location on the map background. 

 Type the topic text. 
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More elements 

Use commands on the Ribbon's Home or Insert tabs to add other topic elements. 

 

Topic Notes 

For more extensive, detailed information.   

 Select a topic and click Notes. 

 Enter the text in the Notes window that appears at the bottom of the 
screen. 

 Use the commands that appear to the left to format or add hyperlinks 
within the note. 

 

Attachments 

To attach documents to topics and embed them in the map file.   

 Select a topic and click Attachment. 

 Select the file you want to upload and attach to the map. You can add 
multiple attachments to a single topic. 

 Point to the attachment icon to see what is attached; click an attachment 
name to open it. 

 

Hyperlinks 

To point to other locations.  

 Select a topic and click Hyperlink. 

 Enter the URL in the dialog. 
You can add mutiple hyperlinks to a single topic. 

 Click the hyperlink icon to see the links for the topic; click a link to jump 
to that destination. 

 

Images 

For visual interest. 

 Select a topic and click Image. 

 Select the image you want to add to the topic. 

 Use the Align Image command on the Design tab to adjust its placement 
within the topic. 

 

Boundaries 

For grouping or summarizing topics. 

 Select a topic (the boundary will surround or summarize it and all its 
subtopics). 

 Click Boundary or press CTRL+SHIFT+B, or use the pull-down to select a 
specific boundary type. 

 

Relationships 

For showing connections between topics 

 Click Relationship. 

 Click the first topic, and then the second. 

You can add even more information to your map by including Task Info, coding topics with Markers, adding 
SharePoint Linker topics, and using formatting to highlight or categorize topics. 
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Add and edit topics 

You build a map by adding topics, and then organizing them into a useful hierarchy.  

What do you want to do? 

Add topics 

Select topics 

Edit topics 

Move and copy topics 

Delete topics 

  

Add topics 

Central topic 

When you start a new map the central topic appears with placeholder text. 

 Click to select the central topic, and type your map’s theme or title. 

 Press Enter when you are finished. 

Other topics 

You can add topics, subtopics, floating topics, and callouts using the keyboard, or by clicking commands on 
the Home tab on the Mapping window's Ribbon. Select a topic, then: 

To add… Windows press.. Mac press... Or click ... 

Topic at the 
same level 

ENTER Return Topic 

Subtopic INSERT  

CTRL+ENTER 

  

+Return 

Control+Return 

Subtopic 

Callout CTRL+SHIFT+ENTER +SHIFT+Return 

Control+SHIFT+Return 

Callout 

Floating topic*    - - - Floating Topic 

* You do not have to select a topic to add a floating topic. 

You can also  add topics by right-clicking on a topic or on the map background. 

HINT: See Keyboard Shortcuts for additional information. 
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Enter topic text 

New topics appear with placeholder text. 

 While the topic is still selected, simply type to enter your own topic text. 

 For a multi-line topic, press Shift+Enter (Mac: Shift+Return) where you want a line break. 

HINT: Other ways to create new topics are to copy topics within the map, or to add SharePoint Linker 
topics with links to SharePoint tasks. 

Once you've added a topic you can go back and edit its text at any time. To make a topic stand out you can 
format it with text and fill colors, or use a distinctive topic shape. 

Select topics 

Select a single topic or object 

 Click the topic or object. A highlight appears to show that it is selected.  

Select multiple topics and objects 

 Hold down the CTRL key (Mac:  key) and click to select or de-select them. 

 Hold down the SHIFT key and use the arrow keys to select additional topics. 

 Press CTRL + A (Mac: +A) to select all the topics and elements on the map. 

HINT: See Keyboard Shortcuts for additional information. 

Select all topics within a particular area on the map 
 

 Click and drag a rectangle. All topics that 
the rectangle touches will be selected. 

 

De-select topics 

 To de-select individual topics press CTRL (Mac:  key) and click them. 

 To de-select all topics, click the map background. 

Edit topics 

Replace a topic’s text 

 Select the topic and type the new text. 

You can also use the Find & Replace feature to replace text in multiple topics. 

Modify a topic’s text 

1. Select the topic. 
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2. Click inside the text to start edit mode. 

3. Once you are in edit mode, you can edit the text as you do in most applications. 

HINT: See Keyboard Shortcuts for additional information. 

Multi-line topics 

 To create a multi-line topic, press Shift+Enter (Mac: shift+return) where you want a line break. 

 You can drag the topic's sizing control   , or its left or right edge to control the way the topic 
text wraps. To return the topic to a single line, double-click the topic's left or right edge. 

Move and copy topics 

Drag and drop topics 

You can move the topics on your map by simply clicking and dragging one or more topics to a new location. 

 

Select the topic(s) and drag them to a new position on the map. A red 
visual cue appears showing where the topic(s) will be added. 

HINT: Hold Shift as you drag to prevent the topic from attaching to 
other topics. 

Cut, Copy, and Paste topics 

Do one of the following: 

 Select a topic, and then click Cut or Copy on the Ribbon's Home tab. 

 Right-click a topic, and then click Cut or Copy. 

 Select a topic, and then press CTRL+X or CTRL+C (Mac:  +X or +C). 

Then, do one of the following: 

 Select another topic, or click the map background, and then click Paste on the Ribbon's Home tab. 

 Right-click another topic, and then click Paste Topic. 

 Select another topic, or click the map background, and then press CTRL+ V (Mac:  +V). 

The cut or copied topic will be pasted as a subtopic of the selected topic. 

HINT: You can also use the right-click commands to create links between map topics. 

Delete topics 

To delete topics, do any of the following: 

 Select one or more topics, and then press Del (Mac: Delete). 

 Select one or more topics, and then click Delete on the Ribbon's Home tab. 

 Right-click a topic, and then click Delete Topic. 

HINT: If you delete a topic in error you can click Undo   on the top toolbar. 
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To remove a topic but keep its sub-topics, do one of the following: 

 Right-click the topic, and then click Remove Topic. 

 Select the topic, and then press CTRL+SHIFT+DEL. 

See also: 

Add other information 

Add visual elements 

Code topics with markers 

Format a map 

  

View and navigate 

The Mindjet Connect SP mapping window provides you with a variety of commands to help you move 
through and view your map. Many commands also have keyboard shortcuts. 

What do you want to do? 

Minimize the ribbon 

Navigate 

Pan and zoom 

Change the level of detail 

Filter the map 

Find and replace text 

  

Minimize the ribbon 

You can minimize the ribbon to expand the mapping area and see more of your map. 

 To minimize the Mindjet Connect SP ribbon, click the Minimize Ribbon  button at upper-right. 

 To see the ribbon again, click a tab on the ribbon, or click the Restore Ribbon    button. 

Navigate 

You can move between topics using the keyboard: 

 Use the arrow keys (left, right, up, down) to move between topics 

 Tab to move to the next topic. 

Pan and zoom 

For smaller maps navigation is straightforward when the map is displayed at full size with all topics shown. 
For larger maps you may find it helpful to zoom out, change the level of detail , or focus on a topic to view a 
specific part of the map. 
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Panning 

To move the map, use the scroll bars along the map side and bottom, or click and hold on the map 

background until you see the hand cursor   , and drag it . 

HINT: Wheel mouse users can scroll using the wheel. 

To center the map, click Center Map on the ribbon's View tab. 

Zooming 

To adjust the Zoom factor enter a factor on the ribbon's View tab. 

To fit the map to the window, click Fit Map ribbon's View tab, or right-click the map background, and then 
click Fit Map. 

Change the level of detail 

You can change the level of detail displayed for individual topic trees as well as for the entire map. 

Collapse and expand topics 

You can collapse or expand topics interactively using the icons that appear on each topic with subtopics. 

 Click  to expand the topic (see its subtopics) 

 Click  to collapse the topic (hide its subtopics). 

Change the level of Detail 

1. Select topics: 

 To change the level of detail for the whole map select the central topic or select nothing 
(click the map background). 

 To change the level of detail for a topic tree, select the tree's parent topic. 

2. Choose the level of detail: 

 On the ribbon's View tab, click the Expand pull-down to choose the level of detail. 

 Click the top part of the button to progress through the detail levels for the map or branch. 

 Click Next Level to expand the map or topic one level at a time. 

Focus on topic 

The Focus on Topic command shows the selected topic centered and expanded to an optimum level. Its 
sibling topics and other main topics are collapsed. 

1. Select the topic. 

2. On the View tab, click Focus on Topic. 

Filter the map 

NOTE: you cannot filter the map in Read-only mode. 
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You can use the Filter command to hide or show selected topics on your map. The Central Topic and the 
parents of displayed topics are always shown. 

1. Select one or more topics. 

2. On the View tab on the ribbon, click Show Selected Topic or Hide Selected Topic . 

HINT: Filtering is cumulative: To filter the map further, repeat the Filter process again. 

To remove the filter, click Remove Filter. 

Find and replace text 

To quickly find some text in your map: 

 Enter it in the Find box in the upper-right corner of the mapping window, and then press Enter or 
Return.  

 Press Enter or Return again to find the next occurrence. The command searches the map in a 
clockwise direction, starting with the topic at upper-right. 

You can find and optionally replace text in your map topics using the Find and Replace options in the Task 
Pane.  

1. Click  to open the Task Pane. 

2. Enter the text to search for, then click Next to search in a clockwise direction or Previous to search 
counter-clockwise . The first topic with matching text will be selected. 

3. Then, do one of the following: 

 To find the next matching topic (clockwise) click Next . 

 To find the previous matching topic click Previous . 

 To replace the text with new text, enter the new text in the Replace With field. 
Click Replace  to change the text in the selected topic, or click Replace All to change all 
matching text in the map to the new text. 

NOTES: 

The Find command only searches through topic text, Tags, and task info Resources. It does not 
search text in topic Notes or in Attachments. 
 
The Replace command can only be used to replace topic text. You cannot use this command in Read-
only mode.  

See also: 

Add and edit topics 
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Add other information 

Map topics are most easily read and understood when their text is brief. You can include more information 
on your map by using a variety of topic elements to contain that information without detracting from the 
map's clarity. 

What do you want to learn about? 

Notes 

Hyperlinks 

Attachments 

Task info 

  

Notes 

Map topics are most readable when they are kept short. For topics that need 
more detail, you can add topic notes to include more information. Topic notes 
can be formatted, and can include hyperlinks and graphics.  

Enter Notes text 

1. Select the topic. 

2. On the Ribbon's Home tab, click Notes. 

HINT: Right-click a topic and then click Notes. 

3. Enter the note in the notes pane below the map window. (You may need to drag the splitter up to 
see the window.) You can type the text or copy it from another document. 

4. Format the note as you desire by selecting text and using the formatting buttons in the notes pane. 

A Notes icon  appears on the topic to show that it contains a note. Point to this icon to see a summary of 
the note. The Notes text appears in the notes pane whenever you select the topic. 

Include a hyperlink in Notes 

1. Select some text in the notes pane. 

2. Enter the link destination in the link location box after http://. 
For example: www.mindjet.com. 

3. The text will automatically be formatted to show that it contains a link. 

To remove the link, select the text again and delete the address from the link location box. 

Hyperlinks 

You can add a link to a topic that points to a web address or to a document. You 
can also create links that point to other topics in the current map. You can add 
multiple links to a single topic.  
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Create a hyperlink to a URL  or document 

If you are linking to a document, copy the URL of the link's target: Right-click the document name in its 
document library, and then, in the shortcut menu, click Copy Shortcut. Now, open the map and proceed 
with the following steps. 

1. Select a topic. 

2. On the Ribbon's Home or Insert tab, click Hyperlink. 

HINT: Right-click a topic, then click Add Hyperlink. 

3. In the dialog, enter  or paste a link destination. You can enter a link with an http:// address. 

4. Click Add. 

5. You can continue to add more hyperlinks. The list of hyperlinks that will be added appears with 

buttons for editing  or removing  individual links.  

6. When you are ready to add the links to the map, click Save. 

You'll see a link icon   appear on the topic. Point to the icon to see the link destination. If the topic 
contains multiple links, click the icon to see the list of links. 

When you click this icon (for a single link) or the link in the list (for multiple hyperlinks), the link is activated, 
and the web page or document opens.  

NOTE: Other users must have access to the document in order to activate a document link. 

Create a link to a topic 

You can create a link to a topic on the current map using right-click commands. 

1. Right-click the topic you want to link to (the target topic), and then click Copy as Hyperlink. 

2. Right-click the topic where you want to create the link, and then click Paste as Hyperlink. 

You'll see a link icon  appear on the topic. When you click this icon, the link is activated and the target 
topic is selected.  

Edit or remove hyperlinks 

1. Right-click the hyperlink icon on the topic, and then click Manage Hyperlinks. 

2. In the dialog, click the edit  or delete    buttons to modify or remove a link. 

3. When you are finished, click Save. 



Creating and editing maps 

17 

Attachments 

You can attach a document to a topic, such as a Word document, a spreadsheet, 
a text file or other document type. The attached document becomes part of the 
map, independent from the original source document, and is saved with the 
map. You can add more than one attachment to a topic. 

.   

Add an attachment 

1. Select a topic. 

2. On the Ribbon's Home or Insert tab, click Attachment. 

HINT: Right-click a topic, then click Add Attachment. 

3. In the dialog select a document. 

You'll see an attachment icon  appear on the topic. 

View an attachment 

 

When you point to the attachment  icon you will see the list of 
attachments. 

When you click the icon, the attachment list opens. Click on the 
attachment that you want to view. It will download and open in its 
native application. 

In order for you to open an attachment, the attachment's document type must be associated with an 
application on your system. 

NOTE: You can only view, but not edit attachments with Mindjet Connect. If you edit the attachment 
while you have it open your changes are not saved back to the map. 

Remove an attachment 

1. Right-click the attachment icon on the topic and then click Delete Attachment. 

2. In the list that appears, click the attachment you want to delete from the topic. 

Task info   

Task information is shown by marker icons (for priority and % complete) 
and as text displayed in a small window below the topic (for Resources, 
Duration, and Start and Due dates). 

 

Add task info to a topic 

1. Select a topic. 

2. On the Ribbon's Home tab, select the Priority and Progress icons you want to use. 

When you change these icons on a topic in a SharePoint task dashboard, the related SharePoint task 
is also updated. * 
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3. To provide additional details, click Task Info and use the Task Info pane options to select and enter 
the information for the topic. 

HINT: The Show Task Info and Show year in dates options apply to all task info on the map. 

Change or remove a topic's task info 

To change a topic's Task Info: 

 Right-click the Task Info text, and then click Change. 

You can remove the textual task info displayed below a topic directly. (Task info icons can be removed in the 
same way as other icon markers.) 

 Right-click the Task Info text, and then click Remove. 

* NOTE: You cannot modify other task info for tasks that are SharePoint Linker results. You can 
modify their properties only by editing the SharePoint task. 

See also: 

Add SharePoint task dashboards and new tasks 

Code topics with markers 

  

Add SharePoint task dashboards and new tasks 

You can create task dashboards on your map by adding SharePoint Linker topics that are dynamically linked 
to SharePoint tasks.  

When you add a SharePoint Linker topic, you use a wizard to specify criteria to use as a query. When you 
finish selecting criteria in the wizard, the query is executed. The SharePoint Linker topic appears on your 
map, with a subtopic for each matching task. You can refresh the query at any time to get up-to-date 
results. 

The task topics on your map are dynamically linked to their corresponding SharePoint tasks, and you can 
edit the tasks directly from your map. 

You can also create new SharePoint tasks from the Mindjet Connect SP mapping window Ribbon. If the new 
task matches the criteria for any SharePoint Linker topics on your map, a results topic will be displayed for it 
when you refresh the SharePoint Linker topic. 

What do you want to do? 

Add a SharePoint Linker topic to your map 

Edit SharePoint tasks and task topics 

Create new SharePoint tasks 
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Add a SharePoint Linker topic to your map 

To add a SharePoint Linker topic to your map: 

1. On your map, select a topic. (The SharePoint Linker topic and its results will become subtopics of the 
topic you select.) 

2. On the ribbon's Home tab or Insert tab, in the SharePoint group, click Search Tasks. 

3. A wizard appears that lets you specify a site connection and the other criteria for matching tasks.   

The first step in every wizard prompts you to choose one or more SharePoint site connections. 

a. Enter a site url (for example: http://project_site/alpha_project/ ) and then click Add.  
Repeat for all the sites you want to search. 

b. Select the sites (or sub-sites) in your list of available sites. A check-mark appears next to the 
sites you have selected. 

c. Click Next. 

4. On the following screens, use any combination of filter criteria. 

 Select whether to return tasks Assigned to yourself (Me), all users (Anyone) or another user 
identified by their name (First Name and Last Name together) or email address.   

 Note that selecting Anyone may slow down performance due to the possibility of an 
extremely large result set. 

 Filter tasks based on SharePoint task due date 

 Filter tasks based on SharePoint priority (SharePoint has only three priorities) 

 Filter tasks based on a word (or words) contained in the Title, Description, or any text field in 
the task. Separate keywords by commas. 

 Filter tasks based on the SharePoint task status field by (Any or Not Started or Completed), 
or select Range Between and enter the range for the SharePoint % Complete field. 

Click Next to step through the wizard screens, and then click Finish. 

The SharePoint Linker topic appears on your map, with a subtopic for each matching task.  (You'll see a 

"Loading..." icon   while the query executes.) 

For more information about editing or moving results topics, see Edit SharePoint tasks and task topics. 

If your system can't connect to the SharePoint server (due to an error in the URL or an interrupted 

connection) the SharePoint Linker topic will display an icon   showing that the topic is disconnected. 

Refresh the SharePoint Linker results 

You can see up-to-date results for your SharePoint Linker topics at any time. 

 To refresh the query results, click the Refresh icon   on the parent SharePoint Linker topic. 
Subtopics may be removed (if a task no longer meets the criteria) or added (if a task now meets the 
criteria). 
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Edit SharePoint tasks and task topics 

SharePoint Linker results task topics feature two-way communication with their corresponding SharePoint 
tasks, so you can edit tasks in SharePoint Linker topic results directly from your map. 

 To change the Priority or % Complete setting for the task, change the Priority or Progress markers on 
the topic. The SharePoint task properties are automatically updated. The topic text and other topic 
elements cannot be edited on your map. 

 To change other  task properties, click the topic's hyperlink to the task (shown as a browser icon, for 

example  ). The task will open in a new window for editing in SharePoint. When you save the task, 
your map will be updated based on the new properties. 

Move or copy SharePoint Linker results topics 

You can move the parent SharePoint Linker topic freely without affecting its functionality. 

If you move or copy a results topic,  it becomes independent of the SharePoint Linker topic -  it retains its link 
to the SharePoint task, but it cannot be refreshed. When you refresh the SharePoint Linker topic query, a 
new results topic is added to replace the one you moved. This can create duplicate items on your map. 

Create new SharePoint tasks 

1. On the ribbon's Home tab, in the SharePoint group, click Create Task. 

2. The page for creating the task in your default SharePoint task list opens in a new browser tab or 
window. (You can navigate to a different list to create the task in a different location.)   

Enter the task properties, and then click Save. 

When you have finished creating the task, you can close the browser tab or window, and then refresh the 
SharePoint Linker topics on your map. If the new task meets the criteria for any of these topics, a topic linked 
to the new task will be added to your map. 

 

Add visual elements 

Visual elements can be used to indicate connections (relationships) or groupings (boundaries), or simply to 
make topics more memorable (images). 

What do you want to learn about? 

Relationships 

Boundaries 

Images 
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Relationships    

Sometimes a relationship exists between two (or more) topics, and you want to 
illustrate this on your map. You can add a relationship line that connects two 
topics, and label it if you wish. You can change the look of the relationship using 
the Task Pane's Format settings. 

 

Add a relationship 

1. On the Ribbon's Insert tab, click Relationship. 

HINT: Right-click a topic, and then click Insert Relationship. 

2.  When the cursor changes to the Relationship cursor, click the first topic, and then click the 
second topic. 

The relationship line appears connecting the two topics. The topics will remain connected even if they are 
moved. If you move one or both of the topics connected by a relationship, the line will automatically adjust. 

  

Modify and format the relationship 

 

 

When you select a relationship, handles appear so you can re-shape it or change 
its connection point. 
  

Change the shape of the line 

 Select the relationship, then drag the handles . 

Relationship lines follow an optimal path by default because their Auto Layout attribute is enabled. If you 
re-shape the line, the Auto Layout option is automatically disabled. If you want the line to return to its 
optimal path you can re-enable the Auto Layout option in the right-click shortcut menu. 

Connect to a different topic 

 Select the relationship then drag the connection handle   to another topic. 

Format the line's style and color 

1. Select the relationship line(s). 

2. Use the commands on the Ribbon's Home tab to change its line style and color. 

3. For more options, open the Task Pane and use the Format group settings. 

Add a callout (label) to the relationship 

1. Select the Relationship. 

2. On the Ribbon's Home tab, click Callout. 

HINT: Right-click the relationship line, and then click Insert Callout. 

3. When the generic callout appears enter your text. 
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4. Format the callout using the settings on the Ribbon's Home and Design tabs. 

Remove a relationship 

 Select the relationship line, and then click Delete on the Ribbon's Home tab. 

HINT: Right-click the relationship line, and then click Delete Relationship. 

Boundaries 

Boundaries come in two basic types: grouping boundaries and summary boundaries. 

 

  

 

Grouping boundaries can be used to 
emphasize the relationships between 
topics and subtopics with an outline 
surrounding an area on a map with your 
choice of line type and an optional fill 
color. 
  

  Summary boundaries can be used to 
reduce a set of subtopics into a single 
summary topic and then allow this topic to 
grow again. 

Create a boundary 

1. Select the topic whose subtopics you want to group with the boundary. 

2. On the Ribbon's Insert tab, click Boundary. 

HINT: You can add boundaries within boundaries. 

Format, modify, or copy a boundary 

 

When you select a boundary, blue highlighting appears to show that it is 
selected. Then you can change the boundary's formatting. 
  

Format a boundary 

1. Select the boundary. 

2. Use commands on the Ribbon's Home and Design tabs to change its line style, fill color, and 
transparency. 

3. For more options, open the Task Pane and use the Format group settings. 

 Add a summary topic (callout) to a boundary 

1. Select the boundary. 

2. On the Ribbon's Home tab, click Callout. 
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HINT: Right-click the boundary and click Insert Callout. 

3. When the generic callout appears enter your text. 

4. Format the callout using the settings on the Ribbon's Home and Design tabs. 

HINT: You can expand the summary topic into a new topic tree by adding subtopics to it. 

Remove a boundary 

 Select the boundary and click Delete  on the Ribbon's Home tab. 

HINT: Right-click the boundary and click Delete Boundary. 

Move or copy a boundary 

1. Select the boundary and click Cut or Copy on the Ribbon's Home tab. 

2. Select a topic. The boundary will enclose this topic and its subtopics. 

3. Click Paste on the Ribbon. 

Images   

You can add images from JPG, GIF, and PNG files to your map. Images 
can be either attached to an existing topic or added to new topics. You 
can add images to topics, subtopics, floating topics, and callouts. 

 

Add an image 

1. Select a topic, or create a new topic, callout, or floating topic. 

2. On the Ribbon's Home tab, click Image. 

Right-click a topic then click Add Image. 

3. Choose the image you want to insert on the topic. 

Position the image 

The image placement settings allow you to orient the image relative to the topic text. 

1. Select the topic that contains the image. 

2. On the Ribbon's Design tab, click Align Image, and select the placement you want to use. 

Re-size an image 

1. Select the image inside the topic. 

2. Drag the corner handles  to re-size the image. Hold Shift as you drag to change the image's 
aspect ratio. 

To return the image to its original size, right-click the image, and then click Reset Image Size. 

Remove an image 

 Right-click the image inside the topic, then click Delete Image. 
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See also: 

View and navigate 

Format a map 

  

Code topics with markers 

You can add two types of markers to your maps - icons  and tags - using 
commands on the Ribbon and in the Task Pane. An icon marker is a small 
image  that gives information about a topic in a graphical, easily understood 
way. A tag is a brief notation that gives information by displaying the text 
below the topic. 

 

See all the available markers 

 In the Task Pane, open the Map Markers group. 

 Use the and  controls to expand and collapse marker groups. 

Icon markers 

Mindjet Connect comes with a set of icon markers that you can use for coding your topics. 

Apply icon markers to a topic 

1. Select one or more topics. 

2. On the Ribbon's Insert tab, click Icons and select the icon in the pull-down.  

3. If you don't see the icon you want to use, click Organize Icon Markers to open the Task Pane. In the 
Task Pane Map Markers group, click on a marker in one of the Icon Markers groups. 

You can assign several icons from different groups to a single topic, but you may only use one icon from 
each group. (Markers within the groups are mutually exclusive.) The Symbols group is an exception: You 
may assign more than one marker from this group to a topic. 

Change icon markers on a topic 

1. Select the topic. 

2. Do one of the following: 

 Right-click the icon, and then click Change. In the Task Pane, click on a different icon in the 
same group as the icon you want to change. 

 Click the icon on the topic to cycle through other icons in that group. Press SHIFT and click to 
cycle in reverse. 

Remove icon markers from a topic 

1. Right-click the marker on the topic. 

2. Then do one of the following: 

 Click Remove to remove this single marker from the topic. 
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 Click Remove All to remove all the markers from the topic. 

Move or copy icon markers 

 To copy a marker, drag the marker to a different topic. 

 To move it, hold CTRL as you drag it. 

Tags 

You can create your own groups of tags to use. A group is usually a category or class, and the marker names 
within the group are its sub-categories. 

Example: 

You could create the group  "Sample size" 
with markers named "0-1"  ,   "2-5"  ,   "6-10"  ,   ">10"  . 

These would display beneath the topics as: 
       Sample size: 0-1 
       Sample size 2-5 
... and so on. 

Create a new tag group 

1. In the Task Pane, open the Map Markers group. 

2. Under Tags click Add Tag Group. 

3. Enter the Group name. 

4. Click Add. 

Add tags to a group 

You can add new tags to a new, empty group, or to an existing group. 

1. Right-click the group name in the Task Pane's Map Markers group, and then click New Tag. 

2. Enter the Name for the tag, and then click Add. 

3. Repeat these steps to add more tags. 

Apply tags to a topic 

1. Select one or more topics. 

2. Click on a marker in one of the Tag groups. 

You can assign several tags to a single topic, from one or more groups. (Markers within groups are not 
mutually exclusive.) 

Remove tags from a topic 

 Right-click the tag on the topic, and then click Remove. (This removes all tags.) 

 Select the topic, then click the tag to remove in the Markers pane. 

Rename or remove tags from a group 

1. In the Task Pane, right-click the marker you want to rename or remove. 

2. Click Rename Tag or Delete Tag. 
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Rename or remove a tag group 

 In the Task Pane, right-click the group name, and then click Delete Group. 

 In the Task Pane, right-click the group name, click Rename Group, and then enter the new name. 
Group names on the map will update automatically. 

Format a map 

You can format your map with colors and fonts to distinguish topics, change the shape of the connecting 
lines and the type of layout, and apply numbering to topics. 

You can change the format of boundaries and relationships using the options in the Format tab of the Task 
Pane. 

What do you want to do? 

Format map topics 

Change the map layout 

Change the map background color 

  

Format map topics 

1. Select one or more topics. 

2. Select the attributes for the topic and its text on the Ribbon's Home tab. 

3. For more options, click the Design tab. 

HINT: You can also format a portion of the topic text by selecting it and then using the options in the 
Font group. 

Change the map layout 

1. Select one or more topics. 

2. On the Ribbon's Design tab, select the options for the map layout. 

Growth applies to the current topic and its subtopics. 

Topic Lines applies to the lines from the current topic to its subtopics. You can choose a shape and 
the Line Anchor position (the location of the connecting point of lines from the current topic to its 
subtopics). 

Change map background color 

1. Right-click an empty place on the map, and then click Background Color. 

2. Select a color, then click OK. 
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Number topics 

You can number topics with your choice of numbering schemes. Numbering is enabled by selecting a parent 
topic in a topic tree. It is dynamic - if you move or delete a numbered topic the numbering of the tree is 
automatically adjusted. 

1. Select the topic whose subtopics you want to number. 

2. On the Ribbon's Home tab, click Numbering. 

3. Choose the numbering type. 

4. Click Depth, and choose a level. 

Remove numbering 

1. Select the parent of the numbered topics. 

2. On the Ribbon's Home tab, click Numbering, and then click Remove Numbering. 

Save and close a map 

When you are done editing your map, you must save it to commit your changes. 

 Click the File tab, and then click Save. 

 Click Close to return to the document library page. 

If you have the map checked out, you should check it in so others can see your changes and edit the map. 

Print a map 

You can print the current view of a map from the mapping window. It will print with topics expanded or 
collapsed, hidden or visible, just as you see on your screen. You can choose to print either the whole map or 
you can click and drag to select an area of the map to print. 

1. On the ribbon, click the File tab, and then click Print. 

2. In the Print Preview, choose the options you want to use. 

HINTS:  
Click and drag on the map preview to select a specific area to print. 
The map background is not included by default. Omitting the background can make your map 
print faster, and saves ink. 

3. Click Print. 

4. In the Print dialog, select the printer you want to use, and then click Print. 
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Keyboard shortcuts 

You can use these shortcuts in the Mindjet Connect SP mapping window.  

NOTE: The availability of these shortcuts will depend on which browser you are using. Some 
browsers use these keystrokes for other functions. 

Function Windows Mac 

Navigating and Viewing     

Scroll map by large steps  PgUp  /  PgDn   

Ctrl+PgUp / Ctrl+PgDn 

 PgUp  /  PgDn 

+PgUp / +PgDn  * 

Scroll map by small steps  Ctrl+Up / Down +Left / Right / Up / 
Down 

Zoom in  Ctrl+ = Control + = 

Zoom out  Ctrl+ - Control + - 

Fit map to window  Shift+F5 Shift+F5 

Change level of detail  Ctrl+Shift+D Control+Shift+D 

Focus on topic  Shift+F3 Shift+F3 

Find Ctrl + F Control + F 

Open / close Task Pane Ctrl+Shift+T Control+Shift+T  * 

Open  /  close Notes panel Ctrl+Shift+N Control+Shift+N  * 

Inserting topics and objects     

Insert topic Enter Return 

Insert subtopic Insert  or Ctrl+Enter Control + Return  * 

Insert callout Ctrl+Shift+Enter Control + Shift +Return  * 

Add boundary Ctrl+Shift+B Control+Shift+B  * 

Add hyperlink Ctrl+K Control+K 

Selecting topics     

Select next topic Tab Tab 

Select neighboring topic Arrow keys Arrow keys 

Select a group of topics Shift+Left  / Right / Up / Down Shift+Left  / Right / Up / 
Down 

Select additional topics Ctrl + click  or  Ctrl + drag   + click  or    + drag 

Select all topics Ctrl + A Control + A  * 
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Editing topics     

Cut / Copy / Paste Ctrl+X / C / V IE within text only Control+X / C / V 

Undo / Redo Ctrl+Z / Y Control+Z / Y 

Delete selected topic 
(and its subtopics) 

Del Delete 

Remove selected topic 
(retain subtopics) 

Ctrl+Shift+Delete Control+Shift+Delete  * 

Edit existing topic text F2 F2 

Formatting     

Bold topic text Ctrl+B Control+B 

Italicize topic text Ctrl+I Control+I 

Underline topic text Ctrl+U Control+U 

  *  These commands can be executed using either the command key or the control key. 
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Edit a map in MindManager 

You can edit your map in MindManager for Windows and save the edited map back to your SharePoint site. 

You must have MindManager for Windows installed on your system to use this command. MindManager 8 
for Windows, MindManager 9 for Windows, and MindManager 2012 are supported. If you don't have 
MindManager installed, you can use the link in the pop-up message to install a free trial. 

NOTE: Your ability to open and edit maps is controlled by your permissions in SharePoint. 

What do you want to do? 

Open a map in MindManager 

Edit the map 

Save the map 

  

Open a map in MindManager 

HINT: to prevent others from making changes to the map at the same time, you can use the 
SharePoint commands to check out the map. You are not required to check out the map before 
editing, unless this setting is enabled in your SharePoint environment. 

To open a map for editing in MindManager: 

 Point to the map name in the document list, click the down arrow, and then click Edit in 
MindManager. 

o If no user has the map checked out, the map will open for editing.  

o If you have the map checked out, the map will open for editing, and you'll see the checked-

out indicator at upper left:   . 

o If another user has the map checked out, you can open the map in MindManager in Read-
Only mode, and you'll see the read-only indicator at upper left. 

 

Edit the map 

Use the commands on the MindManager ribbon to edit the map. If the map is read-only, you will be able to 
view, but not edit the map. 

For more information on viewing and editing your map, consult the MindManager Help file. 
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Save the map 

When you are finished editing the map, you must save it to commit your changes. 

 Use the MindManager Save command to save your changes. 

If you have the map checked out, you will be prompted to check it back in to upload the changes to 
SharePoint. Once it is checked in, other users will see your changes, and they will be able to edit the map. 

See also: 

View or edit a map in the browser  
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Using the Mindjet Connect SP Web Part 

Insert the Web Part on a page 

You can use the Mindjet Connect SP Web Part to display a map on a SharePoint page. When you insert this 
Web Part on a page, it displays the map you specify in the Mindjet Viewer. People who view the page can 
view the map interactively, but they cannot edit it. 

What do you want to do? 

Insert the Web Part on the page 

Customize the settings and specify the map to display 

Get Help using the Viewer 

  

Insert the Web Part on the page 

1. First, copy the url of the map (.mmap file) you want to display using the Web Part: Right-click the 
map name in its document library, and then, in the shortcut menu, click Copy Shortcut. You will use 
this shortcut in the next section. 

2. Create a new page or open an existing page. 

3. On the page's ribbon, click the Page tab, and then click Edit. 

4. On the Editing Tools, Insert tab, click Web Part. 
 

 

5. In the Web Parts Categories list, select Mindjet, and then select the Mindjet Connect SP WebPart. 
 

 

6. Click Add. The Web Part appears on the page with the message "No map specified". Continue with 
the next section to customize the settings and specify the map. 
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Customize the settings and specify the map to display 

You can customize the Web Part's settings when you first insert it into a page, or at any time. 

1. Point to the Web Part title, click the down arrow, and then click Edit Web Part. 

 

2. The Web Part properties pane appears at the right, where you can customize the settings and specify 
the map to display. 

Change the displayed size 
  

 

In the Appearance group, change the Height and Width 
settings to display the Web Part at a specific size. 

Specify the map to display 
  

 

In the Mindjet Viewer Properties group paste the URL for 
the map (.mmap file - from step 1 in the previous section) 
into the Mind Map URL field. 

3. Click Apply at any time to check the changes you have made, then click OK when you are finished. 

Complete information on configuring other Web Part properties is available from Microsoft at: 
http://technet.microsoft.com/en-us/library/ee329475(office.12).aspx 

http://technet.microsoft.com/en-us/library/ee329475(office.12).aspx
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Using the Mindjet Viewer  

Get Help using the Viewer 

The Viewer has its own online Help, accessible from the status bar: 

 

It contains instructions for using the Viewer commands to interact with the map. The same information is 
included in this section. 

Introduction 

 What is Mindjet Viewer? 

 What is a map? 

Use the Viewer 

 Orient the map 

 Select topics 

 Change the detail level 

 View topic notes 

 Jump to links 

 Update SharePoint Linker topic results 

 Find text 

 Print this map 

 Embed the Mindjet Viewer on a SharePoint page 

  

Introduction 

Welcome to Mindjet Viewer! The Viewer displays a map that was created by Mindjet visual mapping 
software. 

What is Mindjet Viewer? 

Mindjet Viewer is a self-contained application included with the Mindjet Connect SP Web Part that lets you 
interact with a map. 

What is a map? 

Mind mapping is a powerful technique that allows you to make the most of your brainpower by creating 
maps that use color, lines, and images to capture and organize your ideas, information, and tasks. 
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A mind map is a diagram that presents ideas, information and tasks in a radial, graphical, non-linear 
manner. 

 

Each node on the map is called a topic. A map can contain the following topic types: 

 

One central topic 

 

Main topics that branch off the central topic 

 

Floating topics not connected to the main topic 

 

Callout topics extending from another topic 

 

Subtopics branching off main topics, floating topics or callouts 

Topics are arranged into groupings called branches, in a hierarchy according to their importance. 

Topics can be connected by relationships, and grouped or summarized with boundaries: 

     
 

Use the Viewer 

Orient the map 

Move the map:  

 Click and hold to see the hand cursor , and then drag the map. 

Change the map magnification: 

 Use the Zoom control  . 

Fit the map to the window: 

 Click Fit Map . 

Center the map: 

 Click Center Map  . 
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Select topics 

When you select a topic it shows a blue outline.  

To select a single topic click on it. 

To select multiple topics: 

 Hold CTRL as you click on topics in succession. 

 Click on the map background and drag the selection rectangle. All topics that the rectangle touches 
will be selected. 

 

Change the detail level 

 Click on a topic to show its subtopics, or click   to collapse it. 

 Select one or more topics, right-click, and select the detail level. 

To change the detail level for the whole map: 

 Select the Central Topic, right-click, and then choose the detail level. 

To focus on a topic: 

 Select a topic, click   to focus on it (center and expand it to an optimum level; collapse all other 
topics). 

View topic notes 

 Click the Notes icon   on a topic to see its notes. 

Plain text notes display in the Viewer. Those with special formatting are not displayed. 

 Point to the Notes icon   to see a summary of the Note. 

Jump to links 

 Click the Hyperlink icon  on a topic to jump to the link destination. 

You may also see icons for broken links   - these are links that were on the original map but are not 
supported by Mindjet Viewer (for example links to local files on the sender's system). 
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Update SharePoint Linker topic results 

SharePoint Linker topics display a set of subtopics that are linked to SharePoint tasks that match certain 
criteria. The criteria are defined when the topic is added to the map, and the resulting query is stored with 
the topic in the map. 

You can refresh the SharePoint Linker results displayed on the map you are viewing. 

 On the SharePoint linker topic, click the Refresh icon  . This executes the query, and updates the 
results. 

Find text 

1. Click Find    to search for text in the map. 

2. Enter the text you want to look for. 

3. Click Next or Previous   to find the text, and again to find the next occurrence. 

Print this map 

1. Click Print . 
The map will print just as it is displayed in the Print Preview window - with topics expanded or 
collapsed as shown. 

2. Select the options you want to use. 
 
To select a specific area to print, click and drag on the map preview. 

3. When you're all set, click Print . 

Embed your own map on a SharePoint page 

The Mindjet Connect SP Viewer Web Part is provided as part of Mindjet Connect SP. To learn more, consult 
Insert the Web Part on a page. 
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For administrators 

Administering your Mindjet Connect account 

The Mindjet Connect for SharePoint Administrator's page lets you: 

 Enter an email address for the Mindjet Connect SP administrator.  
(This address is presented to users when you have used up all your available user licenses.) 

 Enter a new license key (when you renew or upgrade your license) 

 See information about your current license, including: 

Contract number 

Licenses used and Licenses available 

Installation Date and license Expiration Date 

 See the list of licensed users 

To see this page: 

1. Navigate to your SharePoint Central Administration page. 

2. Click the Mindjet Connect SP Administration link.  

Licensed users 

Users' access to the Mindjet Connect SP commands for creating and editing maps depends on their 
SharePoint permissions. When a user saves a map, they are automatically counted as a licensed user under 
your Mindjet Connect SP contract. 

 To see all licensed users, expand the Licensed Users group on the Mindjet Connect SP Administration 
page. 

If you have reached the limit of licensed users, additional users will still be able to access the Mindjet 
Connect SP commands, in accordance with their SharePoint permissions, but they will receive a message to 
contact the Mindjet Connect SP administrator at the address displayed here. 

To add more users to your Mindjet Connect SP license, contact Mindjet. You will be provided with a new 
license key that you can enter here. 

  

Mindjet, Mindjet Connect, and MindManager are registered trademarks of Mindjet in the United States and other countries.  
Microsoft and SharePoint are registered trademarks of Microsoft Corporation in the United States and other countries. 
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